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Release Notes

Bria 4 for Windows

1 New and Changed Features
System Requirements
Bria 4 runs on Windows Vista, Windows 7, Windows 8 and 8.1.
Bria 4 does not run on the Windows XP operating system.

1.1 New in Bria 4.1.1
Ability to Configure Auto Update Schedule
The administrator who provisions Bria can configure how often a user is prompted that an update is available.

Improvements on License Manager Window
The License Manager window previously showed messages in yellow font. The text has been changed to appear
in black with an alert icon for better readability.

1.2 New in Bria 4.1
Screen Share Add-in
The Screen Share Add-in allows you to share your screen with other people,
both other Bria users and people who are not Bria users. You need this addin if you want to be a presenter; if you just want to view someone else's
screen, you do not need the add-in; you only need a browser.
Getting Started

Obtain the Screen Share Add-in from the CounterPath Store. You will
receive a license key for the add-in. Start Bria, choose Help > Enter License
Key, and paste the license key to enable this feature.
Starting Screen Share

You will see an extra tab at the bottom. When you are ready, invite people,
and start a session. Bria will show who joined your session. You can
temporarily pause the session so participants do not see your screen.
Recurring Sessions

With the Screen Share Add-in, each subscriber gets a dedicated screen share
link. You can keep using the same link as long as you want; this is
especially helpful when you do screen share repeatedly with the same
members; you do not need to send them a different link every time.
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Disabling Call Waiting
You can choose Disable Call Waiting from the rightclick menu. If you enable this feature, then when you
are on one phone call, any new incoming call will go
straight to voicemail or will ring as busy (to the caller).
In this way, you are not distracted by incoming calls.
You can enable this feature even during a call, and it
will take effect right away. The call will appear in the
Missed Calls in the History tab.

Outgoing Account Selection
Currently, if you have two or more SIP accounts, you can select your “preferred” account. This is the account that
will be used unless you create a dialing plan that includes account selection (in which case the dialing plan
determines which account to use for each phone call).
In Bria 4.1, the behaviour of account selection has been improved. Now:

If your preferred account becomes unavailable, Bria automatically switches to using the next enabled account
in the Account list. The “Calls will made” message on the softphone will show the newly selected account:





When the preferred account becomes available again, Bria automatically reverts to using that account. The
“Calls will be made” message disappears (because it only appears when Bria is using an account other than
the preferred account).
On the Accounts list, the Preferred account field only ever shows the account you selected. If that account
becomes disabled, the selection in that field does not change – it continues to show your preferred account,
but shaded, to show it is not currently available.
When that account becomes available again, the shading is cleared.

Instant Messages
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Previously, if you started an IM to person X and your Message window already showed an active IM for
person X, then Bria would start a new IM. Once you typed a message and sent it, the new and old messages
would be merged into one.
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Now, when you start an IM in this situation, Bria will immediately display the existing IM for this person so
you can see your recent messages with this person.


Improvements have been made to display the Message window:

There is an icon on the softphone:



There is a shortcut key: Shift-Ctrl-M.

Importing Multiple License Keys
You can import or export multiple license keys at once.
This is helpful when you need to transfer licenses to a new machine. Instead of repeating copy and paste for all
the keys, you can export all the keys to one text file, and import the file to Bria on a new computer.
If you are an administrator, this is an easy way to distribute keys to the users.

Changes to Login Screen
The wording on the Login screen has been modified.

You should only choose the Profile to “Enter your Configuration server details” if your system administrator or
VoIP service provider has told you that you must log into Bria before you can use it.
Otherwise, you should choose “I will manually input my account configuration”. In this case, when you click
Continue, Bria starts and the softphone appears.

If this is the first time you are starting Bria, you should immediately choose Softphone > Account Settings,
and create SIP and XMPP accounts using the account information provided by your system administrator or
VoIP service provider.

If you have previously started and configured Bria, you can start using the phone.

Changes to Audio and Video Features
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Now, when you move the volume slider to “no volume”, the Mute icon is activated:
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The Video Preview button has been removed from the softphone toolbar. Removing this button makes the
toolbar less busy.
On Preferences > Devices > Speakerphone Mode, the field “Remove Ring PC Speaker” has been removed.
This feature relies on hardware that does not exist anymore.

Changes to Voicemail and Missed calls
You can now click the Voicemail icon or Missed calls icon even when you do not have voicemail or missed calls.

If you click the Voicemail icon and if you have configured the “Number to dial for checking voicemail” field on
Softphone > Accounts > SIP account > Voicemail, then Bria will connect to your voicemail server. (If you have
not configured to check voicemail, clicking this icon does nothing.)
If you click the Missed calls icon, the History tab appears.
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1.3 New in Bria 4.0
New Look
The look of Bria has been completely redesigned for Bria 4. For more information, see “Comparison of Bria 3.5
to Bria 4.0 for Windows”.

Threaded IMs
The display of incoming and outgoing instant messages has changed in Bria 4. For more information, see
“Comparison of Bria 3.5 to Bria 4.0 for Windows”.
Now, there is just one Messages window where all your instant messages – regular IMs, group chats, chat room
sessions, and broadcast IMs – appear. In addition, there is no longer a separate IM archive window; instead, the
left panel in the Messages window serves as the archive.
The left panel shows:

Yellow background: The active IM (the IM whose content shows on the right).

Black text: IMs that are still active. You can click on the IM and send more messages.

Grey text: Inactive IMs. You can no longer click on the IM and send more messages. Instead, you will have to
start a new IM.

To display the Messages window at any time, choose View > Messages:

Full-screen Option for Video Window
The video window can now be expanded to full screen.
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Sending an IM during a Call
Previously, you could only send an IM to the person you were talking to if their IM address exactly matched the
phone number you used to place the call. Now, Bria will look for a useable IM address for this contact (assuming
the person is a contact) and send the IM using that address.

Detection of 64-bit Outlook
This feature was introduced in Bria 3.5.5 but is included here in case you did not update to that release.
The Outlook account works only with 32-bit Outlook. Bria now detects which version of Outlook 2013 is
installed.

If the 32-bit version is installed, you will be able to choose Add > Outlook Account from the Account
Settings dialog.

If the 64-bit version is installed, then Bria disables this menu item. (K-1360 )

Integration with Plantronics Devices
Changes have been made to the way that Bria for Windows integrates with Plantronics HID-compliant devices.
Now, if Bria 4 detects the new Plantronics HID library (Spokes™ Software for Windows™) on the user’s
computer, it uses that library. If Bria does not detect the library, it uses a CounterPath custom library.
We strongly recommend that you install Spokes. To install,go to http://www.plantronics.com/us/support/softwaredownloads/business-windows.jsp.
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XMPP Cross Domain
This feature was introduced in Bria 3.5.5 but is included here in case you did not update to that release.
With this feature, the user can send/receive IMs and send/receive presence subscriptions for addresses that are
foreign to any of the XMPP accounts set up in Bria. For example, if the XMPP account is zippy-phone.com, the
user can receive IMs from kperera11@gmail.com without having to set up gmail.com as an XMPP account.
(Previously, to receive these IMs, a gmail.com XMPP account would have to be set up).
The XMPP server must allow passthrough of foreign addresses. So Bria will allow the user to attempt to subscribe
to kperera11@gmail.com, but zippy-phone.com may or may not send the subscription request to the gmail.com
XMPP server.
Account Selection with Two Accounts

If two XMPP accounts are set up, traffic for a “foreign domain” will go through one of these two accounts.
Usually it will go through the first enabled account in the list. The foreign-domain address becomes linked to the
account it first went through, so subscription to this address (for presence) only occurs if that account is enabled.
For example, assume Joseph has two XMPP accounts set up in Bria: jsantos@zippy-phone.com and
jsantos1111@gmail.com. Joseph wants to add Kokila at the address kperera11@themediumbusiness.com as a
contact and send IMs and view her presence.
When he adds Kokila, Bria happens to choose the gmail account to send the presence request for
kperera11@themediumbusiness.com. From now on, Joseph can IM Kokila and see her presence (the green icon
when she is online, for example) but only when his gmail account is enabled.
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2 Known Issues
2.1 New Issues in Bria 4.1.1
No Presence of Buddies

In some cases, Bria does not show the presence of buddies; all the buddies' presence is offline or unknown.
This happens when a "blocked" list is applied to Bria accidentally. Users can clear the list as follows:
1. Open Bria, go to Preferences, then Privacy.
2. In the Blocked section, type the XMPP domain for the XMPP account, and click Block.
3. Wait for a minute or so while Bria is being configured.
4. In the same window, select the XMPP domain you just added, and click Unblock.
5. Click OK and go back to Bria's contact list.

2.2 Existing Known Issues since Bria 4.0
Messaging

To start a group chat, you choose one or more contacts (who all have XMPP addresses) and choose Start group
chat. The Messages window appears. At this point, you can add more participants but only until you send the first
message. Once you have sent the first message, you will not be able to add more participants.
A future release of Bria will let you add participants once the session has started.
Migrating Messages from Bria 3.5.x

If you upgrade from Bria 3.5.x to Bria 4.0, your messages (IMs, group chats, chat room sessions) are migrated
over. All these migrated messages are set to inactive, regardless of their age, and they appear as gray in the left
panel. However, the presence icon for the other party in some messages may appear as active (for example,
green), which gives the impression that the session is active. But these sessions are not active.
Call Option Indicators

In Bria 3.5.4 and later, when you choose a call option (letters-to-numbers, anonymous calling, auto-answer,
deskphone), an indicator appears on the call panel for that call, to show that the feature is active.
Bria 4.0 does not include these indicators.
A future release of Bria will re-instate these indicators.
Installer

If you minimize the Install window during an installation, then when the installation ends, the window moves to
the top left corner of the screen where it becomes difficult to close. This is a known issue with the type of
installer used with Bria. When the providers of the installer resolve the problem, CounterPath will implement the
solution. (K851)
Workaround: Do not minimize the Install window during an installation.
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Mobile Intel Express Graphics Chipset

If you are using a computer with Mobile Intel® Express graphics chipsets, the Bria softphone and dialogs may
occasionally “redraw” incorrectly so that the softphone image looks broken up. This is a known issue with WPF
graphics and this line of hardware. Bria will still operate correctly in this state if you turn down graphics
acceleration:

Click Start > Control Panel > Display.

Click the General tab > click Advanced

Click the Troubleshoot tab and drag the slider to the None at the extreme left of the scale. You can also
choose to turn down the hardware acceleration by selecting an intermediate value.

Click OK.
Transferring with Multiple Accounts Enabled

Currently, you cannot transfer a call made on one account by phoning the second person on a different account.
For example, you establish a call with person A using account 1 (for example). You then try to transfer the call to
person B by phoning person B on a different account. The transfer hangs and will not complete, and you will have
to cancel the attempt to transfer. (33888)
Video Issues



Under certain scenarios, HD widescreen remote video will appear squished.
Video is not recorded properly on the Windows 7 operating system. The latest version of Windows Media®
tries to use hardware acceleration wherever it can, so a bad driver may cause faulty playback which results in
a green video screen. (39246)

No Video on Video Window

The video window may show a white screen instead of the video image, after the computer wakes up from sleep
(hibernation).
Workaround: Close and reopen the video window. (K229)
Workgroup

When setting up a workgroup in peer-to-peer mode, the activity of the people the local user adds may not start to
show immediately.
Workaround: click on the Retry button on the Workgroup window to refresh the subscription. (70314)
Directory Searches

If you are working in the Directory in Search on Demand mode and you switch to Type to Filter list, you must
restart Bria. Otherwise, you will not be able to fetch the desired directory entries. (60594)
V-cards and XMPP Account

If the XMPP server supports v-cards they will be pulled in along with the roster when the XMPP account is
enabled. If the v-cards are malformed, then Bria may crash when the XMPP account is enabled.
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3 Third-party Software Notices
AES
This product includes software copyright (C) Mok-Kong Shen 2003. http://www.mokkong-shen.privat.tonline.de/
The original software has been revised. A copy of the revised package is available at forums.counterpath.com.

Ares
This product includes software Copyright 1998 by the Massachusetts Institute of Technology.
Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without
fee is hereby granted, provided that the above copyright notice appear in all copies and that both that copyright
notice and this permission notice appear in supporting documentation, and that the name of M.I.T. not be used in
advertising or publicity pertaining to distribution of the software without specific, written prior permission.
M.I.T. makes no representations about the suitability of this software for any purpose. It is provided "as is"
without express or implied warranty.

Awesomium
This product includes software Copyright 2012 byKhrona LLC. All Rights Reserved.
Awesomium (c) 2012 Khrona LLC. All rights reserved. Awesomium is a trademark of Khrona LLC.
Copyright (c) 2008. The Chromium Authors. All rights reserved.
Copyright (c) 1995-2009 International Business Machines Corporation and others. All rights reserved.
This software is based in part on the work of the Independent JPEG Group.
This software is copyright (c) 1991-1998, Thomas G. Lane. All Rights Reserved except as specified.
Copyright (c) 2000-2002 Glenn Randers-Pehrson.
Copyright (c) 1998-2003 Daniel Veillard. All Rights Reserved

Crypto, Libeay, Libeay32, Open SSL
This product includes software Copyright (c) 1998-2005 The OpenSSL Project. All rights reserved. This product
includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes software
written by Tim Hudson (tjh@cryptsoft.com).
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following
acknowledgment: "This product includes software developed by the OpenSSL Project for use in the OpenSSL
Toolkit. (http://www.openssl.org/)"
4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products
derived from this software without prior written permission. For written permission, please contact opensslcore@openssl.org.
5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names
without prior written permission of the OpenSSL Project.
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6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes
software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)"
THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY EXPRESSED OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING,
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.
====================================================================
/
Original SSLeay License
----------------------/ Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.
This package is an SSL implementation written by Eric Young (eay@cryptsoft.com).
The implementation was written so as to conform with Netscapes SSL.
This library is free for commercial and non-commercial use as long as the following conditions are aheared to.
The following conditions apply to all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code;
not just the SSL code. The SSL documentation included with this distribution is covered by the same copyright
terms except that the holder is Tim Hudson (tjh@cryptsoft.com).
Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed. If this
package is used in a product, Eric Young should be given attribution as the author of the parts of the library used.
This can be in the form of a textual message at program startup or in documentation (online or textual) provided
with the package.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:
1. Redistributions of source code must retain the copyright notice, this list of conditions and the following
disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following
acknowledgement:
"This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)"
The word 'cryptographic' can be left out if the rouines from the library being used are not cryptographic related :).
4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code)
you must include an acknowledgement:
"This product includes software written by Tim Hudson (tjh@cryptsoft.com)"
THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
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LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.
The licence and distribution terms for any publically available version or derivative of this code cannot be
changed. i.e. this code cannot simply be copied and put under another distribution licence [including the GNU
Public Licence.]

CURL
This product includes software Copyright © Daniel Stenberg, daniel@haxx.se. All rights reserved.
COPYRIGHT AND PERMISSION NOTICE
Copyright (c) 1996 - 2008, Daniel Stenberg, <daniel@haxx.se>.
All rights reserved.
Permission to use, copy, modify, and distribute this software for any purpose
with or without fee is hereby granted, provided that the above copyright
notice and this permission notice appear in all copies.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
OR OTHER DEALINGS IN THE SOFTWARE.
Except as contained in this notice, the name of a copyright holder shall not
be used in advertising or otherwise to promote the sale, use or other dealings
in this Software without prior written authorization of the copyright holder.

Expat
This product includes software Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd and Clark
Cooper
Copyright (c) 2001, 2002 Expat maintainers.
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Software.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER
IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

13

© 2014 CounterPath Corporation

Release Notes

Bria 4 for Windows

G.722
This product includes software Copyright © 1996-2005 VoiceAge Corporation. All Rights Reserved.

iLBC
This product includes software Copyright © 1999-2005 Global IP Sound Inc. All Rights Reserved .
All use of the Original Code (GIPS iLBC, and code provided by GIPS as part of any related IETF Standard or
draft standard) is subject to the complete Global IP Sound iLBC Public License, IETF Standard, Limited
Commercial Use (the (License”).
The Source Code version of the Original Code is available under the terms of the Global IP Sound Public License,
v2.0, IETF Version – Limited Commercial Use.

Libxml2
This product includes software Copyright (C) 1998-2003 Daniel Veillard. All Rights Reserved.
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Software.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE DANIEL
VEILLARD BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
Except as contained in this notice, the name of Daniel Veillard shall not be used in advertising or otherwise to
promote the sale, use or other dealings in this Software without prior written authorization from him.

NTP
This product includes code that is Copyright © Tom Horsley, 1997-2004. All rights reserved. The right to

unlimited distribution and use of this program is granted to anyone who agrees to keep the copyright
notice intact and not alter the program.
Opus

This product includes software Copyright © opus-codec.org, 2011-2012. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:
- Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.
- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
- Neither the name of Internet Society, IETF or IETF Trust, nor the names of specific contributors, may be used to
endorse or promote products derived from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS IS'' AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
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ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

SILK

This product includes software Copyright (c) 2006-2011, Skype Limited. All rights reserved.
/***********************************************************************
Copyright (c) 2006-2011, Skype Limited. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, (subject to the limitations in the
disclaimer below) are permitted provided that the following conditions are met:
- Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.
- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
- Neither the name of Skype Limited, nor the names of specific contributors, may be used to endorse or promote
products derived from this software without specific prior written permission.
NO EXPRESS OR IMPLIED LICENSES TO ANY PARTY'S PATENT RIGHTS ARE GRANTED BY THIS
LICENSE. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ''AS
IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
***********************************************************************/

SOCI
This product includes software Copyright (C) 2004-2008 Maciej Sobczak , Stephen Hutton. All rights reserved.
Boost Software License - Version 1.0 - August 17th, 2003
Permission is hereby granted, free of charge, to any person or organization obtaining a copy of the software and
accompanying documentation covered by this license (the "Software") to use, reproduce, display, distribute,
execute, and transmit the Software, and to prepare derivative works of the Software, and to permit third-parties to
whom the Software is furnished to do so, all subject to the following:
The copyright notices in the Software and this entire statement, including the above license grant, this restriction
and the following disclaimer, must be included in all copies of the Software, in whole or in part, and all derivative
works of the Software, unless such copies or derivative works are solely in the form of machine-executable object
code generated by a source language processor.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT. IN NO EVENT SHALL THE
COPYRIGHT HOLDERS OR ANYONE DISTRIBUTING THE SOFTWARE BE LIABLE FOR ANY
DAMAGES OR OTHER LIABILITY, WHETHER IN CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

Speex
This product includes software © 2002-2003, Jean-Marc Valin/Xiph.Org Foundation.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:
 Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.


Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.



Neither the name of the Xiph.org Foundation nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

SQLite
Portions of this application were written using SQLite, http://sqlite.org/

SRTP
This product includes software Copyright (c) 2001-2005 Cisco Systems, Inc.
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:


Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.



Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.



Neither the name of the Cisco Systems, Inc. nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
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DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
VP8

This product includes software Copyright (c) 2010, The WebM Project authors. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:


Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.



Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.



Neither the name of Google, nor the WebM Project, nor the names of its contributors may be used to endorse
or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes software Copyright (c) 2010, Google Inc. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:


Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.



Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.



[Neither the name of Google nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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WebRTC
This product includes software Copyright 2011, The WebRTC project authors. All rights reserved.
Copyright (c) 2011, The WebRTC project authors. All rights reserved. Redistribution and use in source and
binary forms, with or without modification, are permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

Neither the name of Google nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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